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What's new in this release

Edit++ changed its name to EditPlus on Monday, April 13, 1998.

In version 1.04, following improvements and bug-fixes have been made.

Perl support added
EditPlus now provides syntax highlighting and auto-completion feature for Perl.

Document Template feature added
This version provide document template feature and some primitive document template files for 
HTML, C/C++, Perl and Java. This feature is extension of New HTML Page command in previous 
version. See Document Template for more details.

Syntax highlighting improvements and bug-fixes
Additional keywords and color settings are added in customization of syntax highlighting. Also some 
bugs have been fixed. See Syntax Highlighting for details about added keywords.

Regular expression bug fixed
Regular expression didn't work correctly in previous version. This bug has been fixed.

Scanning Cliptext library bug fixed
In previous version, cliptext libraries sometimes could not be found. This bug has been fixed.

Use document's font in input-box of find dialog
Input box in Find/Replace/Find-in-Files dialog box now uses same font as active document. This can 
be useful for users who use upper-ASCII characters and special fonts such as Terminal font.

Output window improvements and bug-fixes
Output window is improved and some bug fixed when double-clicking error line.

Dragging file to Shortcut bug fixed
In previous version, long-named file is converted to short name when dragging to Shortcut of 
EditPlus. Now this bug has been fixed.

Shell file-open bug fixed
Bug fixed in double-clicking long-named file in Explorer.

IntelliMouse support added
Support scrolling using IntelliMouse wheel.

<NOTE>
If you lose all previous preference settings after setup, here is a workaround.
1. Run regedit.exe
2. Open HKEY_CURRENT_USER - Software - ES-Computing
3. You can probably see two entries here, Edit++ and EditPlus. If so, rename EditPlus to other name or 
delete it, then rename Edit++ to EditPlus.
This problem happens because EditPlus changed its name from Edit++ and it will not happen unless you 
upgrage from Edit++.



Revision history

Version 1.04    (04/11/98)
Perl support added.
Document Template feature added.
Syntax highlighting improvements and bug-fixes.
Regular expression bug fixed.
Syntax highlighting color-button bug fixed.
Scanning Cliptext library bug fixed.
Use document's font in input-box of find dialog.
Output window improvements and bug-fixes.
Dragging file to Shortcut bug fixed.
Shell file-open bug fixed.
IntelliMouse support added.
Other minor bug-fixes and improvements.

Version 1.02    (04/03/98)
Printing bug fixed.
DBCS character input bug fixed.
Change horizontal-scrollbar behavior.
Some additional argument macro added.
Customize syntax highlighting bug fixed.
Bug in selection behavior of spell-checker fixed.
Replace text in reverse order bug fixed
Auto-indent bug fixed.
Word-wrap when pasting text bug fixed.
Other minor bug-fixes and improvements.

Version 1.01    (03/24/98)
Modified mouse selection behaviour.
Other minor bug-fixes.
First public-release.

Version 1.00    (03/20/98)
First internal release.



What is EditPlus

Edit++ changed its name to EditPlus on Monday, April 13, 1998.

    EditPlus is Internet-ready 32-bit text editor for Windows 95/98 and Windows NT 4.0 or higher.    It 
is not only a good replacement for Notepad, but also it has much more powerful features for web-page 
authors and programmers.

EditPlus 1.0 is reviewed as top-quality shareware.
Winner! - TUCOWS Golden Calf Award for April, 1998
Sharewarejunkies    5 stars.
ZDNet Software Library    4 stars.

Internet-ready 
EditPlus provides seamless browser window (requires IE 3 or higher), so you can easily preview 
HTML files or Java applets without leaving the editor.

Syntax highlighting 
Customizable syntax highlighting feature is available for HTML, C/C++, Perl and Java.    It can be 
extended to support other languages too.

HTML Toolbar 
EditPlus provides HTML Toolbar which allows quick and easy access to most frequently-used HTML 
tags.

User tools and help files 
EditPlus can execute user-defined tools and optionally capture the output.    You can also define user 
help files.

Auto-completion 
Auto-completion provides quick abbreviation of frequently-used phrases.    This feature can save 
typing and allows more efficient editing.

Cliptext window 
Cliptext window is collection of frequently-used text clips.    You can customize cliptext library by 
simple drag-and-drop.

Document template 
Document template is like a stencil for newly-created document.    You can freely add/remove 
document templates for quick-start of new document.

Other features
EditPlus provides fast and flexible editing capability.    It can handle large text files, and has useful 
features such as powerful undo/redo, word-wrap, showing line number, drag-n-drop editing, powerful 
search and replace, spell checker, splitter window, keystroke recording, customizable keyboard 
shortcuts, and more.



How to install/remove

System requirement 
Windows 95/98, Windows NT 4.0 or higher
2MB free disk space
IE 3 or higher for seamless browser feature (optional)

Install 
Extract EditPlus archive file (EPPxx.ZIP) to temporary directory using PKUNZIP 2.04g or compatible 
program (such as Winzip), then execute SETUP.EXE.

Remove 
Execute 'Uninstall EditPlus' in the EditPlus Start Menu folder or open 'Add/Remove Programs' in 
Control Panel and double-click EditPlus in the list box.



Internet-ready

EditPlus provides seamless browser window (which requires IE 3 or higher).    You can preview content of 
your HTML document or Java applet without leaving the editor. Browser window has common browsing 
features so you can browse internet sites conveniently.

If you don't have IE 3 or higher on your system, EditPlus loads system's default browser or user-defined 
browser as external application.    You can specify browser settings in Tools page of Preferences dialog 
box



Syntax Highlighting

EditPlus provides powerful and customizable syntax highlighting feature for HTML, C/C++, Perl and Java 
by default.    You can customize keyword colors and file extensions for the existing syntax, or you can also
add your own syntax.

In order to add your own syntax type you should write syntax file and add it in the Syntax page of the 
Preferences dialog box.

Syntax file is plain text file which has ".STX" extension and should be written in predefined format.    The 
fastest way is to look into the sample .STX file such as JS.STX for JavaScript file (*.JS).

Header Information

#TITLE=C/C++
#DELIMITER=,(){}[]-+*%/="'~!&|\<>?:;.
#QUOTATION1='
#QUOTATION2="
#LINECOMMENT=//
#WHOLELINE=n
#COMMENTON=/*
#COMMENTOFF=*/
#ESCAPE=\
#CASE=y
#PREFIX1=
#PREFIX2=
#PREFIX3=
#PREFIX4=
#PREFIX5=
#SUFFIX1=
#SUFFIX2=
#SUFFIX3=
#SUFFIX4=
#SUFFIX5=

Each keyword should be prefixed with '#'.
1. TITLE - The title of syntax file.    This should be located at the first line of the file.    Otherwise, 
EditPlus cannot load it.
2. DELIMITER - Specify the delimiter which is used for parsing keywords.    You need not to specify 
space character and tab character here, since those are treated as delimiter by default.
3. QUOTATION1 - Specify quotation mark.    Enter only one character.
4. QUOTATION2 - Specify alternate quotation mark.    Enter only one character.
5. LINECOMMENT - Specify the string which indicates line comment.
6. WHOLELINE - Whole line comment only. Specify 'y' if line-comment string can only be located at 
the beginning of a line (eg. 'rem' for BASIC), otherwise 'n'.
7. COMMENTON - Specify the string which turns on the block-comment.
8. COMMENTOFF - Specify the string which turns off the block-comment.
9. ESCAPE - Specify escape character.    Enter only one character.
10. CASE - Specify case sensitivity. 'y' for yes and 'n' for no.
11. PREFIX1 - PREFIX5 - Specify keyword prefix character. Any word that follows the prefix is treated
as keyword.



12. SUFFIX1 - SUFFIX5 - Specify keyword suffix character. Any word that precedes the suffix is 
treated as keyword.

You can also insert comment line in the syntax file.    Comment line begins with semicolon(;).

 Keyword groups

#KEYWORD
abstract
boolean
break

#KEYWORD
...

Each keyword group begins with #KEYWORD, followed by keyword list.    You can specify up to 5 
keyword groups.



User tools and help files

EditPlus provides a convenient way to add/remove user-defined tools and help files.

You can customize tool items in User Tools page of Preferences dialog box.    You can add up to 20 user-
defined tools and help files.    User tools appears at the bottom of Tools menu.

The output of tool execution can be captured in output window so if you double-click the error line in the 
output window, EditPlus will load the file and locate the caret to that line.

If you execute help file,    EditPlus searches current word of the document in the keyword list of the help 
file and shows the related topic.



Auto-completion

Auto-completion is time-saving feature which changes short abbreviation into the complete string.    
EditPlus provide auto-completion feature for C/C++ files by default.    For example, if you type "if" and 
press space key, it will expand to the following string.

if ()
{
}

In order to use auto-completion feature for other file types, you should write auto-completion file and 
specify its path in the Settings page of the preference dialog box.

Auto-completion file is plain text file which has ".ACP" extension and should be written in predefined 
syntax.    The syntax is very simple.    The fastest way is to look into the sample .ACP file that comes with 
EditPlus.

Header Information

#TITLE=C/C++
#CASE=y

Each keyword should be prefixed with '#'.
1. TITLE - The title of auto-completion file.
2. CASE - Specify case sensitivity.    'y' for yes and 'n' for no.

You can also insert comment line in the auto-completion file.    Comment line begins with semicolon(;).

 Text clips

#T=if
if (^!)
{
}

The format of text clip is the same as that of Cliptext library.    Each text clips begins with title 
information of the form "#T=title".    Title is the abbreviation that you want to expand.    Text body 
comes next.    You can define optional Hot Spot using "^!".    "^" is used as escape character.    If you 
want to insert "^" itself in the text body, you should enter the character twice like "^^".    When you 
insert the "#" in the text body, you also have to prefix with the escape character like "^#".    The text 
body can have multiple lines.    An optional '#' can be placed in the line after the last line to indicates 
the end of the text clip.

#T=if
if (^!)
{
}
#



Document template

You can start new document half-way by using document template. Document template acts like a stencil 
for newly-created document.    You can freely add/remove any document template.

EditPlus provides primitive document templates for HTML, C/C++, Perl and Java.    You can freely 
customize it as you need.    Document template is plain text file.    You can define optional Hot Spot using 
"^!".    Hot Spot will be the caret location when the template is inserted into the document.

You can customize document template feature in Templates page of Preferences dialog box.    You can 
add up to 20 user-defined document template files.    Document templates will be shown at File-New 
menu.



Other features

Multiple settings
You can add or remove file types and specify options for each file type.    For example, you can set 
word-wrap feature off in a plain text file and turn it on automatically when you load an HTML 
document.    You can specify multiple settings in Settings page of Preferences dialog box.

Edit large files 
Unlike Windows' built-in Notepad, it can handle large text files.    The file size is only limited by the 
amount of free system memory.

Powerful undo/redo
EditPlus provides multiple undo/redo, so you can safely cancel any typing error.

Word wrap
Word-wrap feature helps to edit long-line text more conveniently.    You can turn on/off word-wrap 
feature in Word Wrap command of Document menu.

Line number
Showing line number will increase readability of HTML documents and program source codes.    You 
can show on/off line number in Line Number command of Document menu.

Drag and drop editing
EditPlus provides OLE drag and drop editing which is more efficient than clipboard operations.    You 
can also drag and drop text between Cliptext window and the document.

Powerful search and replace
EditPlus provides powerful search and replace feature which can handle Regular Expressions.    
EditPlus also provides Find in Files feature so you can search text in multiple files.    You can also set 
markers at a specific line and go to the marker quickly from any part of the document.    See Search 
menu commands for more details.

Spell checker
EditPlus provides spell checker so you can check typing errors in your document.    Currently, only 
English dictionary is supported.

Splitter window
EditPlus allows user to divide the document into panes and edit different part of the file concurrently.    
To divide current document, choose Split command in Window menu.

Keystroke recording
You can record keystroke and playback it later.    Use Record Keystrokes command in Tools menu.

Customizable keyboard shortcut
You can customize keyboard shortcut of most commands available in EditPlus.    See Keyboard page 
of Preferences dialog box.



EditPlus Version 1 License Agreement

NO WARRANTY

EditPlus IS SOLD "AS IS" AND WITHOUT ANY WARRANTY AS TO MERCHANTABILITY OR FITNESS 
FOR A PARTICULAR PURPOSE OR ANY OTHER WARRANTIES EITHER EXPRESSED OR IMPLIED.   
THE AUTHOR WILL NOT BE LIABLE FOR DATA LOSS, DAMAGES, LOSS OF PROFITS OR ANY 
OTHER KIND OF LOSS WHILE USING OR MISUSING THIS SOFTWARE.

Evaluation and Registration

EditPlus is not free software.    You may use this software for evaluation purposes without charge for a 
period of 30 days.    If you use this software after the 30 day evaluation period, a registration fee is 
required. See ORDER.TXT file or 'Register Information' section in on-line help for detailed information 
about registration method and price list.

Distribution

You may copy the evaluation version of this software and documentation as you wish, and give exact 
copies of the original evaluation version to anyone, and distribute the evaluation version of the software 
and documentation in its unmodified form via electronic means.    But you should not charge or requesting
donations for any such copies however made and from distributing the software and/or documentation 
with other products without the author's written permission.

Registered version

One registered copy of EditPlus may either be used by a single person who uses the software personally 
on one or more computers, or installed on a single workstation used non-simultaneously by multiple 
people, but not both.    You may access the registered    version of EditPlus through a network, provided 
that you have obtained individual licenses for the software covering all workstations that will access the 
software through the network.



Register Information

EditPlus is shareware.    Shareware is 'User supported' or 'Try before you buy' software which requires 
registration fee if you want to use it after the evaluation period.    Your registration helps the author to 
continue improving the software.    See also License agreement.

What you get when register
Registration key will be delivered by e-mail.    Currently program diskette is NOT provided, but the

registration key will unlock the software which you have already downloaded or can download from 
Internet.

Free minor updates and discounts for major upgrades.
Free technical support by e-mail.

Price list
Single user $20
2-10 computers $15 each
11-49 computers $10 each
50+ computers $5 each

CREDIT CARD ORDERS ONLY

You can order with MC, Visa, Amex, or Discover from Public (software) Library in the following ways: 

Online
Go to EditPlus homepage at http://soback.kornet.nm.kr/~escomp/ and click on "Order Online".
OR try following ordering form directly.
https://www.pslweb.com/cgi-win/PSL_ORDs.EXE/ITEM30363
(Secure transaction)
http://www.pslweb.com/cgi-win/PSL_ORD.EXE/ITEM30363
(Normal transaction)
http://209.16.27.194/cgi-win/PSL_ORD.EXE/ITEM30363
(Alternate Site)

FAX
Fax order form to 713-524-6398 ask for product #30363 and please type or block print very plainly.

E-mail
E-mail order form to PsL at "30363@pslweb.com

Mail
Mail order form to PsL at P.O.Box 35705, Houston, TX 77235-5705 ask for product #30363.

THE ABOVE NUMBERS ARE FOR CREDIT CARD ORDERS ONLY.
THE AUTHOR OF THIS PROGRAM CANNOT BE REACHED AT THESE NUMBERS. 

Any questions about the status of the shipment of the order, refunds, registration options, product details, 
technical support, volume discounts, dealer pricing, site licenses, non-credit card orders, etc, must be 
directed to escomp@soback.kornet.nm.kr. 

PsL will notify us within one business day of your order and we will ship the registration key directly to 
you. 



Order form
PSL ORDER FORM, ITEM #30363, EditPlus

IMPORTANT- Your registration key will be delivered by e-mail. Order may not be
processed if you don't provide correct e-mail address.

Single Copy        __ copies at 20 US$ each = _______

Site Licenses
  2- 10 computers  __ computers at $15 each = _______
 11- 49 computers  __ computers at $10 each = _______
 50+    computers  __ computers at $5  each = _______

                              Total payment   _______

First/Middle Name   _________________________________
Last Name           _________________________________
Company name        _________________________________
Your email address  _________________________________
Address line 1      _________________________________
Address line 2      _________________________________
City,State,Zip      _________________________________
Country             _________________________________
Phone # (voice)     _________________________________

Credit card         [ ]MC [ ]VISA [ ]AMEX [ ]Discover
Credit card number  _________________________________
Expiration date     _________________________________
Name On Card        _________________________________
Date, Signature     _________________________________



Feedback and Support

Homepage
http://soback.kornet.nm.kr/~escomp/
If you want to get latest information about EditPlus, please visit the EditPlus Homepage on the web at
the above address.    You can also download and order latest version of EditPlus at the homepage.    If
you have any trouble to access above address, try alternate site at http://surf.to/editplus/.

Feedback
escomp@soback.kornet.nm.kr
You are always welcomed to submit bug reports, suggestions and any comments to the author.    If 
you have any trouble to access above address, try alternate address of editplus@bigfoot.com.

Update notification
If you want to be notified by e-mail when EditPlus is updated, Send e-mail to 
escomp@soback.kornet.nm.kr with subject line of 'subscribe' and with some comments about 
EditPlus.



Title Bar

The title bar is located along the top of a window.    It contains the name of the application and document.

To move the window, drag the title bar.    Note: You can also move dialog boxes by dragging their title 
bars.

A title bar may contain the following elements:
Application Control-menu button
Document Control-menu button
Maximize button
Minimize button
Close button
Name of the application
Name of the document
Restore button



Scroll bars

Displayed at the right and bottom edges of the document window.    The scroll boxes inside the scroll bars 
indicate your vertical and horizontal location in the document.    You can use the mouse to scroll to other 
parts of the document.



Size command (System menu)

Use this command to display a four-headed arrow so you can size the active window with the arrow keys.

After the pointer changes to the four-headed arrow:
1. Press one of the DIRECTION keys (left, right, up, or down arrow key) to move the pointer to the 

border you want to move.
. Press a DIRECTION key to move the border.
3. Press ENTER when the window is the size you want.

Note:    This command is unavailable if you maximize the window.

Shortcut
Mouse: Drag the size bars at the corners or edges of the window.



Move command (Control menu)

Use this command to display a four-headed arrow so you can move the active window or dialog box with 
the arrow keys.

Note:    This command is unavailable if you maximize the window.

Shortcut
Mouse: Drag the title bar



Minimize command (application Control menu)

Use this command to reduce the EditPlus window to an icon.

Shortcut
Mouse: Click the minimize icon  on the title bar.



Maximize command (System menu)

Use this command to enlarge the active window to fill the available space.

Shortcut
Mouse: Click the maximize icon  on the title bar; or double-click the title bar.



Next Window command (document Control menu)

Use this command to switch to the next open document window.    EditPlus determines which window is 
next according to the order in which you opened the windows.

Shortcut
Keys: Ctrl+F6



Previous Window command (document Control menu)

Use this command to switch to the previous open document window.    EditPlus determines which window 
is previous according to the order in which you opened the windows.

Shortcut
Keys: Shift+Ctrl+F6



Close command (Control menus)

Use this command to close the active window or dialog box.

Clicking the close icon on the title bar is the same as choosing the Close command.

Note:    If you have multiple windows open for a single document, the Close command on the document 
Control menu closes only one window at a time.    You can close all windows at once with the Close All 
command on the Window menu.

Shortcuts
Keys: Ctrl+F4 closes a document window

Alt+F4 closes the EditPlus window or dialog box



Restore command (Control menu)

Use this command to return the active window to its size and position before you chose the Maximize or 
Minimize command.



No Help Available
No help is available for this area of the window.



No Help Available
No help is available for this message box.





File menu commands

The File menu offers the following commands:

New Creates a new 
document.

New 
HTML

Creates a new HTML 
document.

New 
Brows
er

Creates a new Browser 
window.

Config
ure 
Templ
ates

Add or removes 
document templates.

Docu
ment 
Templ
ate

Create a new document 
using document 
template.

Open Opens an existing 
document.

Close Closes an opened 
document.

Delete Deletes the active 
document file.

Save Saves an opened 
document using the 
same filename.

Save 
All

Saves all documents.

Save 
As

Saves an opened 
document to a specified 
file name.

Print Prints a document.
Print 
Previe
w

Displays the document 
on the screen as it 
would appear printed.

Print 
Setup

Selects a printer and 
printer connection.

Open 
Heade
r File

Opens the header file of 
the active document.

1, 2, 
3, 4 
comm
and

Opens last documents 
you closed.

Exit Exits EditPlus.



New command (File menu)

Use this command to create a new document in EditPlus.

You can open an existing document with the Open command.

Shortcuts

Toolbar:
Keys: Ctrl+N



New HTML command (File menu)

Use this command to create a new HTML document in EditPlus.

You can open an existing HTML document with the Open command.

Shortcuts
Toolbar:

Keys: Ctrl+Shift+N



New Browser command (File menu)

Use this command to create a new browser window in EditPlus.

If you choose seamless browser window option in Tools page of Preferences dialog box, new seamless 
browser window will be created.    Otherwise, EditPlus launches a new external browser.

Shortcuts
Keys: Ctrl+Shift+B



Configure Templates command (File menu)

Use this command to add/remove/modify the document templates.    Document template this used for 
quick-start of new document.    See Document Template for more information.    This command presents 
Templates page in Preferences dialog box.



Document Template command (File menu)

Use this command to create a new document using document template.    You can add/or remove is menu
items in Templates page of Preferences dialog box.



Open command (File menu)

Use this command to open an existing document in a new window.

EditPlus displays the File Open dialog box so you can choose documents to edit.    You can open multiple 
documents at once.    Use the Window menu to switch among the multiple open documents.    See 
Window 1, 2, ... command.

You can create new documents with the New command.

Shortcuts

Toolbar:
Keys: Ctrl+O



File Open dialog box

The following options allow you to specify which file to open:

File Name
Type or select the filename you want to open.    This box lists files with the extension you select in the 
List Files of Type box.

List Files of Type
Select the type of file you want to open.    You can customize the file types in File Filters page of 
Preferences dialog box.

Drives
Select the drive in which EditPlus stores the file that you want to open.

Directories
Select the directory in which EditPlus stores the file that you want to open.

Network...
Choose this button to connect to a network location, assigning it a new drive letter.



Close command (File menu)

Use this command to close all windows containing the active document.

EditPlus suggests that you save changes to your document before you close it.    If you close a document 
without saving, you lose all changes made since the last time you saved it.    Before closing an untitled 
document, EditPlus displays the Save As dialog box and suggests that you name and save the document.

You can also close a document by using the Close icon on the document's window, as shown below:



Delete File command (File menu)

Use this command to moves current document file to the recycle bin and close all the windows containing 
the document.



Save command (File menu)

Use this command to save the active document to its current name and directory.

When you save a document for the first time, EditPlus displays the Save As dialog box so you can name 
your document.    If you want to change the name and directory of an existing document before you save 
it, choose the Save As command.

Shortcuts

Toolbar:
Keys: Ctrl+S



Save All command (File menu)

Use this command to save all the opened documents to their current name and directory.

This command does not display the Save As dialog box for unnamed documents.

Shortcuts

Toolbar:



Save As command (File menu)

Use this command to save and name the active document.    EditPlus displays the Save As dialog box so 
you can name your document.

To save a document with its existing name and directory, use the Save command.



File Save As dialog box

The following options allow you to specify the name and location of the file you're about to save:

File Name
Type a new filename to save a document with a different name.

Drives
Select the drive in which you want to store the document.

Directories
Select the directory in which you want to store the document.

Network...
Choose this button to connect to a network location, assigning it a new drive letter.



Print command (File menu)

Use this command to print a document.    This command presents a Print dialog box, where you may 
specify the range of pages to be printed, the number of copies, the destination printer, and other printer 
setup options.

Shortcuts

Toolbar:
Keys: Ctrl+P



Print dialog box

The following options allow you to specify how the document should be printed:

Printer
This is the active printer and printer connection.    Choose the Setup option to change the printer and 
printer connection.

Setup
Displays a Print Setup dialog box, so    you can select a printer and printer connection.

Print Range
Specify the pages you want to print:
All 
Prints the entire document.
Selection 
Prints current selected text.
Pages 
Prints the range of pages you specify in the From and To boxes.

Copies
Specify the number of copies you want to print for the above page range.

Collate Copies
Prints copies in page number order, instead of separated multiple copies of each page.

Print Quality
Select the quality of the printing.    Generally, lower quality printing takes less time to produce.



Print Progress Dialog

The Printing dialog box is shown during the time that EditPlus is sending output to the printer.    The page 
number indicates the progress of the printing.

To abort printing, choose Cancel.



Print Preview command (File menu)

Use this command to display the active document as it would appear when printed.    When you choose 
this command, the main window will be replaced with a print preview window in which one or two pages 
will be displayed in their printed format.    The Print Preview toolbar offers you options to view either one 
or two pages at a time; move back and forth through the document; zoom in and out of pages; and initiate
a print job.

Shortcuts

Toolbar:



Print Preview toolbar

The print preview toolbar offers you the following options:

Print
Bring up the print dialog box, to start a print job.

Next Page
Preview the next printed page.

Prev Page
Preview the previous printed page.

One Page / Two Page
Preview one or two printed pages at a time.

Zoom In
Take a closer look at the printed page.

Zoom Out
Take a larger look at the printed page.

Close
Return from print preview to the editing window.



Print Setup command (File menu)

Use this command to specify various printing options and select a printer and a printer connection.    This 
command presents a Print page of Preferences dialog box, where you specify the settings.



Print Setup dialog box

The following options allow you to select the destination printer and its connection.

Printer
Select the printer you want to use.    Choose the Default Printer; or choose the Specific Printer option 
and select one of current installed printers shown in the box.    You install printers and configure ports 
using the Windows Control Panel.

Orientation
Choose Portrait or Landscape.

Paper Size
Select the size of paper that the document is to be printed on.

Paper Source
Some printers offer multiple trays for different paper sources.    Specify the tray here.

Options
Displays a dialog box where you can make additional choices about printing, specific to the type of 
printer you have selected.

Network...
Choose this button to connect to a network location, assigning it a new drive letter.



Open Header File command (File menu)

This command loads the header file of the active document if it is C/C++ file.

Shortcuts
Keys: Ctrl+Shift+H



1, 2, 3, 4 command (File menu)

Use the numbers and filenames listed at the bottom of the File menu to open last documents you closed.  
Choose the number that corresponds with the document you want to open.

You can change number of files that appear in these menu items. See File page in Preferences dialog 
box.



Exit command (File menu)

Use this command to end your EditPlus session.    You can also use the Close command on the 
application Control menu.    EditPlus prompts you to save documents with unsaved changes.

Shortcuts

Toolbar:
Keys: Alt+F4





Edit menu commands

The Edit menu offers the following commands:

Undo Reverse previous editing
operation.

Redo Reverse previous undo 
operation.

Cut Deletes data from the 
document and moves it 
to the clipboard.

Copy Copies data from the 
document to the 
clipboard.

Paste Pastes data from the 
clipboard into the 
document.

Delete Deletes the selection.
Delete
Word

Deletes current word.

Delete
Line

Deletes current line.

Select
Word

Selects current word.

Select
Line

Selects current line.

Select 
All

Selects the entire 
document.

Cut 
Appen
d

Cuts the selection and 
appends to the 
clipboard.

Copy 
Appen
d

Copies the selection and
appends to the 
clipboard.

Trans
pose

Transposes characters 
either side of caret.

Upper 
Case

Changes the selected 
text to upper case.

Lower 
Case

Changes the selected 
text to lower case.

Capita
lize

Capitalizes the selected 
text.

Insert 
Time

Inserts current time.

Insert 
Time 
with 
Secon
ds

Inserts current time with 
seconds.

Insert 
Date

Inserts current date.



Insert 
Date 
in 
Long 
Forma
t

Inserts current date in 
long format.

Expan
d 
Word

Replaces current word 
with the corresponding 
cliptext.

Increa
se 
Indent

Increases the 
indentation of current 
line or selected block.

Decre
ase 
Indent

Decreases the 
indentation of current 
line or selected block.

Insert 
Mode

Toggles the insert mode 
and overwrite mode.



Undo command (Edit menu)

Use this command to reverse the last editing action, if possible.    The name of the command changes, 
depending on what the last action was.    This command is unavailable if there is no editing action done.

Shortcuts

Toolbar:
Keys: Ctrl+Z or

Alt-BACKSPACE



Redo command (Edit menu)

Use this command to reverse the last undo action, if possible.    The name of the command changes, 
depending on what the last undo action was.    This command is unavailable if there is no undo action 
done.

Shortcuts

Toolbar:
Keys: Ctrl+Y



Cut command (Edit menu)

Use this command to remove currently selected data from the document and put it on the clipboard.    This
command is unavailable if there is no data currently selected.

Cutting data to the clipboard replaces the contents previously stored there.

Shortcuts

Toolbar:
Keys: Ctrl+X



Copy command (Edit menu)

Use this command to copy selected data onto the clipboard.    This command is unavailable if there is no 
data currently selected.

Copying data to the clipboard replaces the contents previously stored there.

Shortcuts

Toolbar:
Keys: Ctrl+C



Paste command (Edit menu)

Use this command to insert a copy of the clipboard contents at the insertion point.    This command is 
unavailable if the clipboard is empty.

Shortcuts

Toolbar:
Keys: Ctrl+V



Delete command (Edit menu)

Use this command to delete current selection of the active document.    If there is no selection, this 
command deletes the character at current caret position.

Shortcuts

Toolbar:
Keys: Del



Delete Word command (Edit menu)

Use this command to delete the word at current caret position.

Shortcuts
Keys: Alt+Del



Delete Line command (Edit menu)

Use this command to delete the line at current caret position.

Shortcuts
Keys: Ctrl+Del



Select Word command (Edit menu)

Use this command to select the word at current caret position.

Shortcuts
Keys: Ctrl+W



Select Line command (Edit menu)

Use this command to select the line at current caret position.

Shortcuts
Keys: Ctrl+R



Select All command (Edit menu)

Use this command to select the entire document.

Shortcuts
Keys: Ctrl+A



Cut Append command (Edit menu)

Use this command to cut and append selected data onto the clipboard.    This command is unavailable if 
there is no data currently selected.

Shortcuts
Keys: Ctrl+Shift+C



Copy Append command (Edit menu)

Use this command to copy and append selected data onto the clipboard.    This command is unavailable if
there is no data currently selected.

Shortcuts
Keys: Ctrl+Shift+X



Transpose command (Edit menu)

Use this command to transpose characters either side of the caret.

Shortcuts
Keys: Ctrl+T



Upper Case command (Edit menu)

Use this command to convert the selected text to upper case.    If there is no selected text, this command 
converts the character at current caret position.

Shortcuts
Keys: Ctrl+U



Lower Case command (Edit menu)

Use this command to convert the selected text to lower case.    If there is no selected text, this command 
converts the character at current caret position.

Shortcuts
Keys: Ctrl+L



Capitalize command (Edit menu)

Use this command to capitalizes the selected text.    This command is unavailable if there is no selected 
text.

Shortcuts
Keys: Ctrl+Shift+U



Insert Time command (Edit menu)

Use this command to insert current time into the active document.    The time format does not include 
seconds.    If you want to include the seconds in the time format, use Insert Time with Seconds command.



Insert Time with Seconds command (Edit menu)

Use this command to insert current time into the active document.    The time format includes seconds.    If
you don't want to include the seconds in the time format, use Insert Time command.



Insert Date command (Edit menu)

Use this command to insert current date in short format into the active document.    If you want the long 
format, use Insert Date in Long Format command.



Insert Date in Long Format command (Edit menu)

Use this command to insert current date in long format into the active document.    If you want the short 
format, use Insert Date command.



Expand Word command (Edit menu)

Use this command to expand current word into the corresponding cliptext item.    This command searches
the active cliptext library for the current word, and inserts the matching cliptext item into the active 
document.

Shortcuts
Keys: F2



Increase Indent command (Edit menu)

Use this command to increase the indentation of the selected text using the tab character.    If There is no 
selected text, this commands increases the indentation of the current line.

This command is not available if current document is in word-wrap mode.

Shortcuts
Keys: Ctrl+I



Decrease Indent command (Edit menu)

Use this command to decrease the indentation of the selected text.    If There is no selected text, this 
commands decreases the indentation of current line.    This command works only when the line is 
indented by tab characters.

This command is not available if current document is in word-wrap mode.

Shortcuts
Keys: Ctrl+Shift+I



Insert Mode command (Edit menu)

Use this command to toggle the input state between insert mode and overwrite mode.

Shortcuts
Keys: Ins





View menu commands

The View menu offers the following commands:

Toolba
r

Shows or hides the 
toolbar.

HTML 
Toolba
r

Shows or hides the 
HTML toolbar.    This 
command is only 
available when the 
document window is 
activated.

Brows
er 
Toolba
r

Shows or hides the 
Browser toolbar.    This 
command is only 
available when the 
seamless browser 
window is activated.

Status
Bar

Shows or hides the 
status bar.

Clipte
xt 
Windo
w

Shows or hides the 
Cliptext window.

Output
Windo
w

Shows or hides the 
output window.

Toggle
Focus

Switches the input focus
between the cliptext 
window and the 
document window.

Full 
Scree
n

Toggles the full screen 
mode on and off.

View 
in 
Brows
er

Loads the active 
document into the web 
browser.



Toolbar command (View menu)

Use this command to display and hide the standard Toolbar, which includes buttons for some of the most 
common commands in EditPlus, such as File Open.    A check mark appears next to the menu item when 
the Toolbar is displayed.

See Toolbar for help on using the toolbar.



Toolbar

The Standard Toolbar is displayed across the top of the application window, below the menu bar.    The 
Standard Toolbar provides quick mouse access to many tools used in EditPlus.    

The Standard Toolbar is dockable to any side of the main window and can be a resizable floating window 
too.    You can move the Standard Toolbar by dragging the gripper which is located at the left or top edge 
of the toolbar.    The Standard Toolbar can be allowed to show double column when docked vertically.    
See the Tools page of Preferences dialog box.

To hide or display the Toolbar, choose Toolbar from the View menu (Alt, V, T).

Click To
Opens a new document.

Opens an existing document.    EditPlus displays the Open dialog box, in which you can locate 
and open the desired file.

Saves the active document with its current name.    If you have not named the document, EditPlus
displays the Save As dialog box.

Saves all documents.

Displays the document on the screen as it would appear printed.

Prints the active document.

Checks spelling in the active document.

Creates a blank HTML page.

Removes selected data from the document and stores it on the clipboard.

Copies the selection to the clipboard.

Inserts the contents of the clipboard at the insertion point.

Deletes the selection.

Reverse the last editing.

Reverse the last undo action.

Finds the specified text.

Replaces specific text with different text.



Searches for a string in multiple files.

Go to specified line in the active document.

Toggles the word-wrap feature of the active document.

Toggles the auto-indent feature of current document.

Shows or hides the line number of the active document.

Sets the preferences    This command presents Preferences dialog box.

Shows or hides the cliptext window.

Shows or hides the output window.

Toggles Full Screen mode on and off.

Displays help for clicked on buttons, menus and windows.

Quits the application; prompts to save documents.



HTML Toolbar command (View menu)

Use this command to display and hide the HTML Toolbar, which includes buttons for common HTML tags. 
The HTML Toolbar appears automatically when you open an HTML document and disappears when you 
close the document.    A check mark appears next to the menu item when the HTML Toolbar is displayed.

See HTML Toolbar for help on using the HTML toolbar.



HTML Toolbar

The HTML Toolbar provides a convenient way to write HTML document quickly and easily.    It provides 
quick mouse access to most commonly used HTML Tags plus useful tools such as HTML Color Picker, 
Character Picker, Table Generator and Object Picker.

The HTML Toolbar is displayed across the top of the document window.    The HTML Toolbar appears 
automatically when you open an HTML document and disappears when you close the document.

The HTML Toolbar is fixed and can not be moved on other side of the window. However it can be allowed 
to be wrapped when there is not enough space to show all the buttons.    See the Tools page of 
Preferences dialog box

To hide or display the HTML Toolbar, choose HTML Toolbar from the View menu (Alt, V, H).

Click To

Loads the active document into the web browser.

Sets the selected text bold (toggle).

Sets the selected text italic (toggle).

Sets the selected text underlined (toggle).

Sets the font of the selected text.

Inserts an color code.    This command presents the HTML Color Picker.

Inserts a Non Breaking Space.

Inserts a Break tag.

Inserts a Paragraph tag.

Sets the selected text Heading.

Inserts an Image.

Inserts an Anchor.



Inserts a Horizontal Ruler.

Inserts a Comment.

Inserts a special character.    This command presents the Character Picker.

Inserts a Table.    This command presents the Table Generator.

Centers the selected text (toggle).

Sets the selected text Block Quotation (toggle).

Sets the selected text Preformatted (toggle).

Inserts a List.

Inserts a Script.

Inserts an Applet.

Inserts an Object.    This command presents Object Picker.

Inserts a Form.

Inserts a Form Control.

Insert an Image Map.

Insert a Frame.



Browser Toolbar command (View menu)

Use this command to display and hide the Browser Toolbar, which includes buttons for some of the most 
common browser commands in EditPlus.    A check mark appears next to the menu item when the 
Browser Toolbar is displayed.

See Browser Toolbar for help on using the Browser toolbar.



Browser Toolbar

The Browser Toolbar is displayed across the top of the seamless browser window.    The Browser Toolbar 
provides quick mouse access to Browser commands available in EditPlus.

The Browser Toolbar is fixed and can not be docked on other side of the window.

To hide or display the Browser Toolbar, choose Browser Toolbar from the View menu (Alt, V, B).

Click To

Edits the source of current HTML page.

Goes back one step.

Goes forward one step.

Stops loading current page.

Refreshes content of current page.

Opens the start page.

Selects the font size.

Searches the Internet.

Displays the contents of your favorites folder.

Goes to EditPlus Homepage.



Status Bar command (View menu)

Use this command to display and hide the Status Bar, which describes the action to be executed by the 
selected menu item or depressed toolbar button, and keyboard latch state. A check mark appears next to 
the menu item when the Status Bar is displayed.

See Status Bar for help on using the status bar.



Status Bar

The status bar is displayed at the bottom of the EditPlus window.    To display or hide the status bar, use 
the Status Bar command in the View menu.

The left area of the status bar describes actions of menu items as you use the arrow keys to navigate 
through menus.    This area similarly shows messages that describe the actions of toolbar buttons as you 
depress them, before releasing them.    If after viewing the description of the toolbar button command you 
wish not to execute the command, then release the mouse button while the pointer is off the toolbar 
button.

The right areas of the status bar indicates the status of the active document and the editor:

Indicator Description
ln 1 Current line of the active document.
col 1 Current column of the active document.
1 Total lines of the active document.
PC Indicates current file format. PC, UNIX or MAC.
REC Indicates whether the keystroke recording is turned on or off.
INS Indicates whether current input mode is insert mode or overwrite mode.
READ Indicates whether the active document is read-only or not.



Cliptext Window command (View menu)

Use this command to display and hide the cliptext window, which provides a convenient way to handle 
frequently-used text clips. A check mark appears next to the menu item when the cliptext Window is 
displayed.

See Cliptext Window for help on using the cliptext window.

Shortcuts
Toolbar:

Keys: Alt+1



Cliptext Window

The cliptext window is collection of text clips which provides quick and easy access to the frequently-used
text clips.    Cliptext window is located at the left side of the screen.    To display or hide the Cliptext 
window, use the Cliptext Window command in the View menu.

EditPlus provides some sample cliptext libraries such as HTML 3.2 tag collection.    You can easily edit the
content of the sample libraries or create your own cliptext library.

Inserting cliptext item into the document 
Double-click the item in the listbox, and the text will be inserted into the active document.    Or 

drag and drop the item into the document.      See Insert command for details.
Add cliptext item 
Click right mouse button on the listbox. Then choose Add command at the pop-up menu.    Or 

select the text in the document, drag and drop the selected text into the listbox.    This command presents 
Add cliptext Item dialog box.

Remove cliptext item 
Click right mouse button on the listbox. Then choose Remove command at the pop-up menu.
Edit cliptext item 
Click right mouse button on the listbox. Then choose Edit command at the pop-up menu.    This 

command presents Edit cliptext Item dialog box.
Move cliptext item 
Drag and drop the cliptext item to the desired position in the listbox.    Items can not be moved if 

the cliptext library is sorted.    See Sort Cliptext command.
Direct editing the cliptext file
Click right mouse button on the combobox.      Then choose Edit command at the pop-up menu.    

The cliptext library file (which has ".CTL" extension) will be loaded into the editor.      the Cliptext library file
should be written in predefined syntax.    See Edit Cliptext Library command for detail about the syntax of 
cliptext libraries.
See also: 

Edit Cliptext Library
Cliptext listbox pop-up menu

Cliptext combobox pop-up menu



Cliptext Listbox Pop-up Menu

Cliptext listbox pop-up menu provides following commands:

Insert Inserts the selected 
cliptext item into the 
active document.

Edit Edits the selected 
cliptext item.    This 
command presents Edit 
Cliptext Item dialog box.

Add Add a new cliptext item.  
This command presents 
Add Cliptext Item dialog 
box .

Remo
ve

Removes the selected 
cliptext item.

Sort Toggles the sort mode of
current cliptext library.

Reloa
d

Reloads current cliptext 
library from the file.

Hide Hides the cliptext 
window.



Cliptext Combobox Pop-up Menu

Cliptext combobox pop-up menu provides following commands:

Refres
h

Refreshes the list of 
cliptext libraries.

New Creates a new cliptext 
library.    This command 
presents New Cliptext 
Library dialog box.

Edit Loads current cliptext 
library into the editor.

Save Saves current cliptext 
library to the file.

Rena
me

Renames current 
cliptext library.

Delete Deletes current cliptext 
library.

Hide Hides the cliptext 
window.



Insert command (Cliptext Listbox pop-up menu)

Use this command to insert current cliptext item into the active document.    You can also drag and drop 
the cliptext item to the document to get the same result.

Cliptext can define Hot Spot (using "^!").    Hot Spot will be the caret location when the cliptext is inserted 
into the document.    If there is any selected text in the document, cliptext with Hot spot will be wrapped 
both side of the selection.

For example, if following cliptext
<TITLE>^!<TITLE> 

is inserted into following selected text
Document Title

then the result is
<TITLE>Document Title<TITLE>



Edit command (Cliptext Listbox pop-up menu)

Use this command to edit current cliptext item.    This command presents Edit Template Item dialog box.    
You can define Hot Spot in the cliptext using "^!".    Hot Spot will be the caret location when the cliptext is 
inserted into the document.    See Insert Cliptext Item command for details about Hot Spot.



Add command (Cliptext Listbox pop-up menu)

Use this command to add a new cliptext item.    This command presents Add Template Item dialog box.    
You can define Hot Spot in the cliptext using "^!".    Hot Spot will be the caret location when the cliptext is 
inserted into the document.    See Insert Cliptext Item command for details about Hot Spot.



Remove command (Cliptext Listbox pop-up menu)

Use this command to remove current cliptext item.



Sort command (Cliptext Listbox pop-up menu)

Use this command to toggle the sort mode of current cliptext library.    A check mark appears next to the 
menu item when cliptext library is in sort mode.    Cliptext items can not moved in sorted library.



Reload command (Cliptext Listbox pop-up menu)

Use this command to reload current cliptext library from the file.    After you edited cliptext library file 
directly, you should reload the library to make changes appear.



Hide command (Cliptext Listbox pop-up menu)

Use this command to hide the cliptext window.    You can show the cliptext window back using Cliptext 
Window command in View menu.



Refresh command (Cliptext Combobox pop-up menu)

Use this command to refresh the list of cliptext library in combobox.    This command re-scan the cliptext 
libraries from the hard disk.



New command (Cliptext Combobox pop-up menu)

Use this command to create a new cliptext library.    This command presents New Cliptext Library dialog 
box.    This command creates new empty cliptext library file on the hard disk and refreshes the cliptext 
library list in combobox.    You can add cliptext item in this library using Add command.



Edit command (Cliptext Combobox pop-up menu)

Use this command to load the current cliptext library file (which has ".CTL" extension) into the editor and 
edit it directly.    The cliptext library file should be written in predefined syntax.    The syntax is very simple.  
The fastest way is to look into the sample cliptext library that comes with EditPlus.

 Header Information

#TITLE=HTML 3.2
#INFO
EditPlus Cliptext Library v1.0 
Written by ES-Computing.
#SORT=y

Each keyword should be prefixed with '#'.
1. TITLE - The title of cliptext library.    This should be located at the first line of the file.    Otherwise, 
EditPlus cannot load it.
2. INFO - Information about the cliptext library such as author, date, etc.    This information can have 
multiple lines.
3. SORT - Whether the cliptext library should be sorted or not in the listbox. 'y' for yes and 'n' for no.

 Text clips

#T=BODY
<BODY>
^!
</BODY>

Each text clips begins with title information of the form "#T=title", followed by text body.    You can 
define optional Hot Spot using "^!". "^" is used as escape character.    If you want to insert "^" itself in 
the text body, you should enter the character twice like "^^".    When you insert the "#" in the text body,
You also have to prefix with the escape character like "^#".    The text body can have multiple lines.    
An optional '#' can be placed in the line after the last line to indicates the end of the text clip.

#T=BODY
<BODY>
^!
</BODY>
#

The title-only text clips are also supported.    The title itself will be inserted into the document.    For 
example,

#T=font-family: 

The above item has only title and not text body, so "font=family: " will be inserted into the document.



Save command (Cliptext Combobox pop-up menu)

Use this command to save current cliptext library to the file.



Rename command (Cliptext Combobox pop-up menu)

Use this command to rename the title of current cliptext library.    This command presents Rename 
Cliptext Library dialog box.



Delete command (Cliptext Combobox pop-up menu)

Use this command to move the current cliptext library file to the Recycle bin.    After deleting the file, the 
list of cliptext library in the combobox will be refreshed.



Edit Cliptext Library dialog box

In this dialog box, you can edit the title and the text body of current cliptext item.    This dialog box is also 
used when you add new cliptext item.

Title
Enter the title of the cliptext item.

Text body
Enter the text body of the cliptext item.    "^" is regarded as escape character which is used to define 
Hot Spot.    If you want to enter "^" itself, you should enter it twice like "^^".    You can define Hot Spot 
using "^!".    Hot Spot will be the caret location when the cliptext is inserted into the document.    See 
Insert command for more details.



New Cliptext Library dialog box

In this dialog box, you can create new cliptext library file.

File name
Enter the file name of the cliptext library.    EditPlus automatically appends ".CTL" extension to the file,
so do not include the extension manually.

Title
Enter the title of the cliptext library.      This title will be appear in the combobox of the cliptext window.

Sort
Specify whether the cliptext library should be sorted or not.    If you check this option, the list of cliptext
items will be shown sorted in the listbox of the cliptext window.



Rename Cliptext Library dialog box

In this dialog box, you can rename the title of current cliptext library.

Current title
Current title of the cliptext library will be shown here.

New title
Enter the new title of the cliptext library here.



Output Window command (View menu)

Use this command to display and hide the Output window, which displays the output of user tools.

See Output Window for more help on Output window.

Shortcuts
Toolbar:

Keys: Alt+2



Output Window

The output window is located at the bottom of the screen and displays the captured output of user tools.    
To display or hide the output window, use the Output Window command in the View menu.

If you add a Java compiler to the User Tools page of Preferences dialog box and check the "capture 
output" option, the Java compiler errors will be displayed in the output window.    If you double-click on the
specific error line, EditPlus automatically loads the related file and locates the cursor to that line.

The output window is also used in Find in Files command.    The find result will be displayed in the output 
window, so you can double-click the specific line to load the file and locate the cursor to that line.



Toggle Focus command (View menu)

Use this command when you want to move the keyboard input focus to the cliptext window, or to the 
document window from the cliptext window.

Shortcuts
Keys: F5



Full Screen command (View menu)

Use this command if you want to change full screen mode on and off.    In full screen the document 
window is covers the entire screen so you have more space to view the document.

Shortcuts
Toolbar:

Keys: Alt+0



View in Browser command (View menu)

Use this command if you want to view current document in browser window.    If you check the seamless 
browser option in Tools setting, the document will be shown in the seamless browser window.    Otherwise
the document will be shown in external browser.    See Tools page of Preferences dialog box for details.

Shortcuts
HTML Toolbar:

Keys: Ctrl+B





Search menu commands

The Search menu offers the following commands:

Find Finds the specified text.
Find 
Next

Finds the next matching 
text.

Find 
Previo
us

Finds the previous 
matching text.

Repla
ce

Replaces specific text 
with different text.

Find in
Files

Searches for a string in 
multiple files.

Go to 
Line

Goes to specified line in 
the active document.

Match 
Brace

Searched for a matching
brace.

Toggle
Marke
r

Set and clear marker at 
current line.

Clear 
All 
Marke
r

Clears all marker from 
the active document.

Next 
Marke
r

Goes to next marker 
position.

Previo
us 
Marke
r

Goes to previous marker
position.



Find command (Search menu)

Use this command to search specific text in current document.    This command presents Find dialog box.

Shortcuts
Toolbar:

Keys: Ctrl+F



Find Next command (Search menu)

Use this command to search for next matching word.

Shortcuts
Keys: F3



Find Previous command (Search menu)

Use this command to search for previous matching word.

Shortcuts
Keys: Shift+F3



Find dialog box

In this dialog box, you can find specific text in current document.    Following options are available.
Find What

Enter text that you want to search for.    EditPlus supports regular expression.    You can press down-
arrow button for regular expression templates.    See Regular Expression for more details.

Case sensitive
Check this option if you want case-sensitive searching.

Whole word only
Check this option if you want to search whole word only and ignore text which is a substring of 
another word.

Regular expression
Check this option if you want to search regular expression.    Regular expression allows more 
sophisticated and powerful search.    See Regular Expression for more detail about regular expression
syntax.

Up
Check this option if you want to search downward from current position.

Down
Check this option if you want to search upward from current position

Find
Press this button to find specified text with current options.



Regular Expression

Regular expression is a search string that contains normal text plus special characters which indicate 
extended searching option.    Regular expression provides more sophisticated search and replace.

For example, you can find any digit by using regular expression "[0-9]".    Similarly you can find any 
matching character that is NOT digit by using regular expression "[^0-9]".    

EditPlus supports following regular expressions in Find, Replace and Find in Files command.    

Expr
essi
on

Description

. Matches any character.
| Either expression on its 

left and right side 
matches the target string. 
For example, "a|b" 
matches "a" and "b".

[] Any of the enclosed 
character may match the 
target character.    For 
example, "[ab]" matches 
"a" and "b".    "[0-9]" 
matches any digit.

[^] None of the enclosed 
character may match the 
target character.    For 
example, "[^ab]" matches 
all character EXCEPT "a"
and "b".    "[^0-9]" 
matches any non-digit 
character.

* Character to the left of 
asterisk in the expression
should match 0 or more 
times. For example "be*" 
matches "b", "be" and 
"bee".

+ Character to the left of 
plus sign in the 
expression should match 
1 or more times. For 
example "be+" matches 
"be" and "bee" but not 
"b".

? Character to the left of 
question mark in the 
expression should match 
0 or 1 time. For example 
"be?" matches "b" and 



"be" but not "bee".
^ Expression to the right of 

^ matches only when it is 
at the beginning of line.    
For example "^A" 
matches an "A" that is 
only at the beginning of 
line.

$ Expression to the left of $
matches only when it is at
the end of line.    For 
example "e$" matches an
"e" that is only at the end 
of line.

() Affects evaluation order 
of expression and also 
used for tagged 
expression.

\ Escape character.    If you
want to use character "\" 
itself, you should use "\\".

The tagged expression is enclosed by ().    Tagged expressions can be referenced by \0, \1, \2, \3, etc.    \0
indicates a tagged expression representing the entire sub-string that was matched.    \1 indicates the first 
tagged expression, \2 is the second, etc.    See following examples.

Original Search      Replace      Result      
abc (ab)(c) \0-\1-\2 abc-ab-c 
abc a(b)(c) \0-\1-\2 abc-b-c 
abc (a)b(c) \0-\1-\2 abc-a-c



Replace command (Search menu)

Use this command to search specific text in current document and replace it with different text.    This 
command presents Replace dialog box.

Shortcuts
Toolbar:

Keys: Ctrl+H



Replace dialog box

In this dialog box, you can find specific text and replace it with different text in current document.    
Following options are available.

Find What
Enter text that you want to search for.    EditPlus supports regular expression.    You can press down-
arrow button for regular expression templates.    See Regular Expression for more detail.

Replace With
Enter text that you want to replace the found text with.    EditPlus supports regular expression.    You 
can press down-arrow button for regular expression templates.    See Regular Expression for more 
detail.

Case sensitive
Check this option if you want case-sensitive searching.

Whole word only
Check this option if you want to search whole word only and ignore text which is a substring of 
another word.

Regular expression
Check this option if you want to search regular expression.    Regular expression allow more 
sophisticated and powerful search.    See Regular Expression for more detail about regular expression
syntax.

Up
Check this option if you want to search downward from current position.

Down
Check this option if you want to search upward from current position



Find
Find specified text with current options.

Replace
Replace found text with specified text.    If the text is not found yet, this is same as Find command.

Replace All
Perform find and replace for the entire document without prompts.



Find in Files command (Search Menu)

Use this command to search specific text in multiple files.    This command presents Find in Files dialog 
box.

Shortcuts
Toolbar:



Find in Files dialog box

In this dialog box, you can find specific text in multiple files.    Following options are available.

Find What
Enter text that you want to search for.    EditPlus supports regular expression.    You can press down-
arrow button for regular expression templates.    See Regular Expression for more details.

File type
Enter wild card pattern of the files that you want to find text in.    When you specify more than one 
pattern, separate each one with semicolon(;).    For example, if you want to find in HTML files, use 
"*.html;*.htm".

Folder
Specify the folder that the searching takes place.

Include sub-folders
Search also sub-folders of the specified folder.

Case sensitive
Check this option if you want case-sensitive searching.

Whole word only
Check this option if you want to search whole word only and ignore text which is a substring of 
another word.

Regular expression
Check this option if you want to search regular expression.    Regular expression allow more 
sophisticated and powerful search.    See Regular Expression for more detail about regular expression
syntax.

Find
Find specified text with current options.



Go To Line command

Use this command to go to specific line in the document.    This command presents Go To Line dialog box.

Shortcuts
Toolbar:

Keyboard: Ctrl+G



Go To Line dialog box

This dialog box prompts you to enter the line number that you want to search for.    Enter proper line 
number and press OK.



Match Brace command (Search menu)

Use this command to search for matching brace for current character.    This command works only if 
current character is brace.

Shortcuts
Keys: Ctrl+]



Set Marker command (Search menu)

Use this command to set/clear current line as marker.    You can search for the marker position using Next
Marker and Previous Marker commands.

Shortcuts
Keys: F9



Clear All Marker command (Search menu)

Use this command to clear all the markers currently set.    This command is unavailable if there if no 
marker in current document.

Shortcuts
Keys: Ctrl+Shift+F9



Next Marker command (Search menu)

Use this command to search for next marker position.    You can set/clear marker using Set Marker 
command.

Shortcuts
Keys: F4



Previous Marker command (Search menu)

Use this command to search for previous marker position.    You can set/clear marker using Set Marker 
command.

Shortcuts
Keys: Shift+F4





Document menu commands

The Document menu offers the following commands:

Line 
Numb
er

Shows or hides the line 
number of the active 
document.

Word 
Wrap

Toggles the word wrap 
feature of the active 
document.

Auto 
Indent

Toggles the auto-indent 
feature of the active 
document.

Auto 
Compl
ete

Toggles the auto-
completion feature of the
active document.

PC 
File 
Forma
t

Sets the active 
document to the PC file 
format.

UNIX 
File 
Forma
t

Sets the active 
document to the UNIX 
file format.

MAC 
File 
Forma
t

Sets the active 
document to the MAC 
file format.

Tab 
Size

Sets the tab size of the 
active document.



Line Number command (Document menu)

Use this command to show or hide the line number of the active document.    Line number may increase 
readability in program sources or HTML documents.

Shortcuts
Toolbar:



Word Wrap command (Document menu)

Use this command to turn on or off the word-wrap feature of current document.    Word-wrap feature helps
to edit long-line text more conveniently.

Shortcuts
Toolbar:



Auto Indent command (Document menu)

Use this command to turn on or off the auto-indent feature of current document.    When this feature is 
turned on, a new line will be automatically indented same as previous line.

Shortcuts
Toolbar:



Auto Completion command (Document menu)

Use this command to turn on or off the auto-completion feature of current document.    See Auto 
Completion for more details.



PC File Format (Document menu)

Use this command to set the format of the active document to the PC format.    If you want to save your 
document in the UNIX or MAC format, use UNIX file format or MAC file format command.



UNIX File Format (Document menu)

Use this command to set the format of the active document to the UNIX format. If you want to save your 
document in the PC or MAC format, use PC file format or MAC file format command.



MAC File Format (Document menu)

Use this command to set the format of the active document to the MAC format. If you want to save your 
document in the PC or UNIX format, use PC file format or UNIX file format command.



Tab Size command (Document menu)

Use this command to set the tab size of current document.    This command presents Tab Size dialog box.



Tab Size dialog box

In this dialog box, you can set tab size of current document.    Enter proper tab size in the edit box and 
press OK.





Bold command (HTML Toolbar)

Inserts Bold HTML tag.

<B></B>

Shortcuts
HTML Toolbar:



Italic command (HTML Toolbar)

Inserts Italic HTML tag.

<I></I>

Shortcuts
HTML Toolbar:



Underline command (HTML Toolbar)

Inserts Underline HTML tag.

<U></U>

Shortcuts
HTML Toolbar:



Font command (HTML Toolbar)

Inserts Font HTML tag.

<FONT SIZE=""></FONT>

Shortcuts
HTML Toolbar:



HTML Color Picker (HTML Toolbar)

The HTML Color Picker helps you to insert HTML color code into the HTML document.    It shows 
Netscape's 216 colors which you can choose with a mouse click.    If you want to insert other color, click 
More button and Choose Color dialog box will be shown.

Shortcuts
HTML Toolbar:



Color Picker (HTML Toolbar)

The Color Picker helps you to choose color conveniently.    Click on the color cell you want to choose.    If 
you want to choose other color, click More button and Choose Color dialog box will be shown.



Non Breaking Space command (HTML Toolbar)

Inserts Non Breaking Space HTML tag.

&nbsp;

Shortcuts
HTML Toolbar:



Break command (HTML Toolbar)

Inserts Break HTML tag.

<BR>

Shortcuts
HTML Toolbar:



Paragraph command (HTML Toolbar)

Inserts Paragraph HTML tag.

<P>

Shortcuts
HTML Toolbar:



Heading command (HTML Toolbar)

This command presents Heading pop-up menu.    Heading 1 - 6 tags are available in Heading pop-up 
menu.

Shortcuts
HTML Toolbar:



Heading 1 command (HTML Toolbar)

Inserts Heading 1 HTML tag.

<H1></H1>



Heading 2 command (HTML Toolbar)

Inserts Heading 2 HTML tag.

<H2></H2>



Heading 3 command (HTML Toolbar)

Inserts Heading 3 HTML tag.

<H3></H3>



Heading 4 command (HTML Toolbar)

Inserts Heading 4 HTML tag.

<H4></H4>



Heading 5 command (HTML Toolbar)

Inserts Heading 5 HTML tag.

<H5></H5>



Heading 6 command (HTML Toolbar)

Inserts Heading 6 HTML tag.

<H6></H6>



Image command (HTML Toolbar)

Inserts Image HTML tag.

<IMG SRC="" ALT="">

Shortcuts
HTML Toolbar:



Anchor command (HTML Toolbar)

Inserts Anchor HTML tag.

<A HREF=""></A>

Shortcuts
HTML Toolbar:



Horizontal Ruler command (HTML Toolbar)

Inserts Horizontal Ruler HTML tag.

<HR>

Shortcuts
HTML Toolbar:



Comment command (HTML Toolbar)

Inserts Comment HTML tag.

<!--  -->

Shortcuts
HTML Toolbar:



Character Picker (HTML Toolbar)

The Character Picker helps you to insert HTML special characters into HTML document.    If you click on a
character, the corresponding character code will be inserted into the active document.

Shortcuts
HTML Toolbar:



Table Generator (HTML Toolbar)

The Table Generator helps you to insert table tag into the HTML document.    Press left mouse button on a
table cell and drag to the desired size then release the mouse button.

Shortcuts
HTML Toolbar:



Center command (HTML Toolbar)

Inserts Center HTML tag.

<CENTER></CENTER>

Shortcuts
HTML Toolbar:



Block Quotation command (HTML Toolbar)

Inserts Block Quotation HTML tag.

<BLOCKQUOTE></BLOCKQUOTE>

Shortcuts
HTML Toolbar:



Preformat command (HTML Toolbar)

Inserts Preformat HTML tag.

<PRE></PRE>

Shortcuts
HTML Toolbar:



List command (HTML Toolbar)

This command presents List tag pop-up menu.    Unordered list, Ordered list and Definition list are 
available in List tag pop-up menu.

Shortcuts
HTML Toolbar:



Unordered List command (HTML Toolbar)

Inserts Unordered List HTML tag.

<UL>
<LI>
<LI>

</UL>



Ordered List command (HTML Toolbar)

Inserts Ordered List HTML tag.

<OL>
<LI>
<LI>

</OL>



Definition List command (HTML Toolbar)

Inserts Definition List HTML tag.

<DL>
<DT>
<DD>

</DL>



Script command (HTML Toolbar)

Inserts Script HTML tag.

<SCRIPT LANGUAGE="JavaScript">
<!--

//-->
</SCRIPT>

Shortcuts
HTML Toolbar:



Applet command (HTML Toolbar)

Inserts Applet HTML tag.

<APPLET CODE="" WIDTH="" HEIGHT="">
</APPLET>

Shortcuts
HTML Toolbar:



Object Picker (HTML Toolbar)

The Object Picker helps you to insert object tag into the HTML document.    It lists all the ActiveX object 
which is available on the system.    Double-click the item which you want to insert into the document.

Shortcuts
HTML Toolbar:



Form command (HTML Toolbar)

Inserts Form HTML tag.

<FORM METHOD=POST ACTION="">

</FORM>

Shortcuts
HTML Toolbar:



Form Control command (HTML Toolbar)

This command presents Form Control pop-up menu.    Text Box, List Box, Radio Button, Check Box, Text 
Area, Reset Button, Submit Button, Password Button, Hidden Field and Image are available in Form 
Control pop-up menu.

Shortcuts
HTML Toolbar:



Text Box command (HTML Toolbar)

Inserts Text Box HTML tag.

<INPUT TYPE="text" NAME="">



List Box command (HTML Toolbar)

Inserts List Box HTML tag.

<SELECT NAME=""></SELECT>



Radio Button command (HTML Toolbar)

Inserts Radio Button HTML tag.

<INPUT TYPE="radio" NAME="">



Check Box command (HTML Toolbar)

Inserts Check Box HTML tag.

<INPUT TYPE="checkbox" NAME="">



Text Area command (HTML Toolbar)

Inserts Text Area HTML tag.

<TEXTAREA NAME="" ROWS="" COLS=""></TEXTAREA>



Reset Button command (HTML Toolbar)

Inserts Reset Button HTML tag.

<INPUT TYPE="reset">



Submit Button command (HTML Toolbar)

Inserts Submit Button HTML tag.

<INPUT TYPE="submit">



Password Box command (HTML Toolbar)

Inserts Password Box HTML tag.

<INPUT TYPE="password">



Hidden Field command (HTML Toolbar)

Inserts Hidden Field HTML tag.

<INPUT TYPE="hidden">



Form Image command (HTML Toolbar)

Inserts Form Image HTML tag.

<INPUT TYPE="image" SRC="">



Image Map command (HTML Toolbar)

Inserts Image Map HTML tag.

<MAP NAME="">
<AREA SHAPE="" HREF="" COORDS="" ALT="">

</MAP>

Shortcuts
HTML Toolbar:



Frame command (HTML Toolbar)

Inserts Frame HTML tag.

<FRAMESET ROWS="," COLS=",">
<FRAME NAME="" SRC="" SCROLLING="">
<FRAME NAME="" SRC="" SCROLLING="">

</FRAMESET>

Shortcuts
HTML Toolbar:





Browser menu commands

The Browser menu is only available in seamless browser window.    You need IE 3 or higher installed on 
the system to use seamless browser window feature.    The Browser menu offers the following 
commands:

Favori
tes

Displays the contents of 
your favorites folder.

Edit 
Sourc
e

Edits the source of 
current HTML page.

Go 
Back

Goes back one step.

Go 
Forwa
rd

Goes forward one step.

Stop Stops loading current 
page.

Refres
h

Refreshes content of 
current page.

Fonts Selects the font size.
Home Opens the start page.
Searc
h

Searches the internet.

Option Setting browser options.



Favorites (Browser menu)

EditPlus provides access to favorites folder of IE.    Select internet site that you want to visit.

Edit favorites
This command opens favorites folder where you can edit properties of favorites.
corresponding folder.    Select the folder where you want to file.

Favorites list
Select web site which you want to visit.    Pop-up menu represents sub-folder of the main favorites 
folder.

Shortcuts
Browser Toolbar:



Edit Source command (Browser menu)

Use this command to loads or activates the source of current web page.    EditPlus currently only supports
local files and cannot edit the page on the remote URL.

Shortcuts
Browser Toolbar:

Keys: Ctrl+E



Go Back command (Browser menu)

Use this command to go back one step to last visited web page.

Shortcuts
Browser Toolbar:



Go Forward command (Browser menu)

Use this command to go forward one step to last visited web page.

Shortcuts
Browser Toolbar:



Stop command (Browser menu)

Use this command to stop loading current page.

Shortcuts
Browser Toolbar:



Refresh command (Browser menu)

Use this command to refresh content of current page.

Shortcuts
Browser Toolbar:



Home command (Browser menu)

Use this command to open the start page.

Shortcuts
Browser Toolbar:



Fonts command (Browser menu)

Use this command to set the font size of current page.    This command presents Fonts pop-up menu.

Shortcuts
Browser Toolbar:



Search command (Browser menu)

Use this command to search the internet.

Shortcuts
Browser Toolbar:



Option command (Browser menu)

Use this command to specify internet preferences. This command presents Internet Option dialog box.



EditPlus Home Page command (Browser menu)

Use this command to visit the EditPlus Home Page.

Shortcuts
Browser Toolbar:





Tools menu commands

The Tools menu offers the following commands:

Prefer
ences

Sets preferences.

Spell 
Check
Docu
ment

Checks spelling in the 
active document.

Spell 
Check
from 
Curre
nt 
Positio
n

Checks spelling in the 
active document from 
current position.

Spell 
Check
Selecti
on

Checks spelling in 
current selection.

Spell 
Check
Word

Checks spelling in 
current word.

Recor
d 
Keystr
okes

Starts and stops the 
keyboard macro 
recording.

Playb
ack 
Recor
ding

Plays back the recorded 
keyboard macro.

Stop 
Tool 
Opera
tion

Breaks the operation of 
current tool.

Clear 
Output
Windo
w

Clears the contents of 
the output window.

Config
ure 
User 
Tools

Add or remove user 
tools.

User 
Tools

Run user tools.



Spell Check Document command (Tools menu)

Use this command to check spell in current document.    This command presents Spell Checker dialog 
box.



Spell Check From Current Position command (Tools menu)

Use this command to check spell from current position.    This command presents Spell Checker dialog 
box.



Spell Check Selection command (Tools menu)

Use this command to check spell in current selection.    This command presents Spell Checker dialog box.



Spell Check Word command (Tools menu)

Use this command to check spell in current word.    This command presents Spell Checker dialog box.



Spell Checker dialog box

This dialog box appears when you choose spell checker commands in Tools menu.    In this dialog box, 
words that is not found in dictionary will be shown and prompts user several actions upon that words.

Not found
This field displays the word that was not found in dictionary.

Change to
This field displays the word that will replace the wrong word.    You can specify word if you want to 
change the suggested word.

Suggestions
This listbox shows suggested corrections of the wrong word.    Choose the correct word and it will be 
shown in Change To field.    If there is no proper suggestion, you can directly edit Change To filed.

Replace
Replace the wrong word with the content of Change To field.    This command is not available if there 
is no suggestions.    But if you edit Change To field, this command becomes available.

Replace All
Changes any following word which is same as current one.

Ignore
Ignore current word.

Ignore All
Ignore current word and any following word which is same as current one.

Add
Add current word to user dictionary.    You can specify location of user dictionary in Spell Checker 
page of Preferences dialog box.

Add uncap
Add current word to user dictionary and ignores capitalization of the word.

Options
This command presents Spell Checker page of Preferences dialog box where you can specify several
spell-checking options.



Record Keystrokes command (Tools menu)

Use this command to begin or stop recording the keystrokes.    Recorded keystrokes can be played back 
using Playback Recording command.

Shortcuts
Keys: Ctrl+Q



Playback Recording command (Tools menu)

Use this command to play back the recorded keystrokes.    Keystrokes can be recorded using Record 
Keystroke command.

Shortcuts
Keys: Ctrl+Shift+Q



Stop Tool Operation command (Tools menu)

Use this command to stop the tool which is currently running.    This command is only applicable to the 
console mode application.

Shortcuts
Keys: Ctrl+Break



Clear Output Window command (Tools menu)

Use this command to clear the contents of the output window.    Output window displays output of user 
tools or result of Find in Files command.



Configure User Tools command (Tools menu)

Use this command to add/remove/modify the user tools.    User tool is user-defined application that 
EditPlus launches and optionally captures the output.    This command presents User Tools page in 
Preferences dialog box.



Run User Tools command (Tools menu)

Use this command to run the specified user tool.    User tools can be configured in User Tools page in 
Preferences dialog box.

Shortcuts
Keys: Ctrl+0 - Ctrl+9, Ctrl+Shift+0 - Ctrl+Shift+9





Preferences command (Tools menu)

Use this command if you want to set the options available.    EditPlus does not use confusing multi-row 
tabbed property sheet, but provides preference dialog box which consists of several pages.    Categories 
are shown in the tree control.    You can select the desired item to display the corresponding page.

General 
Specify general options.

Fonts 
Specify fonts for edit window, cliptext window and output window.

Colors 
Specify colors for edit window, line number and output window.

Print 
Specify print options such as margin, header/footer and printer properties.

Files 
Specify file options.

Settings 
Specify settings for each file types.    EditPlus supports multiple settings, so you can specify different 
settings for each different file types.

Syntax 
Specify Syntax highlighting options.

Filter 
Specify file filters which is used in File Open dialog box.

Tools 
Specify tool options.

User tools 
Customize user-tools.

Keyboard 
Customize keyboard shortcuts.

Spell checker 
Specify spell checker options.

Shortcuts
Toolbar:



General page (Preferences dialog box)

In this page, you can specify general options of EditPlus.    Following options are available.

Line space
Specify line space.    The unit is percentage of height of a line.

Combobox history
Specify number of combobox history.    EditPlus maintains history of text that you entered in 
combobox.    When you type text in the combobox, EditPlus will search the list and help you complete 
the remaining part of the text.

Save window position when exit
Check this option to save size and position of the window on exit and restore them at next start-up.

Save workspace when exit
Check this option to save the list of opened files and the caret positions on exit.    EditPlus reloads 
these files when it starts next time.

Create new document at startup
Check this option to create a new document at start-up when there is no other active document.

Allow multiple instances
Check this option to allow multiple instances of EditPlus can run at the same time.

Lock insert mode
Check this option to lock insert mode and does not change the state of the insert mode even if you 
press Insert key.    This is useful if you want to prevent erroneous pressing the Insert key.

Beep when auto-completion
Check this option to beep when auto-completing occurs.    See Auto-completion for more details about
auto-completion feature.

Close brace automatically in HTML tag
Check this option to close brace automatically when you type HTML tags.



Fonts page (Preferences dialog box)

In this page, you can specify fonts.    Following options are available.

Area
Choose area where current font setting should be applied.    You can specify different font setting for 
each area.

Font
This window displays font names which is available on the system.    Choose font name you want.

Font style
This window displays font style that is available in current font.

Size
Choose the size of the font.

Bold
Check this option to apply Bold effect to current font.

Underline
Check this option to apply Underline effect to current font.

Italic
Check this option to apply Italic effect to current font.

Strikeout
Check this option to apply Strikeout effect to current font.

Language
Choose language of current font.



Colors page (Preferences dialog box)

In this page, you can specify colors.    Following options are available.

Area
Choose area where current color setting should be applied.    You can specify different color setting for
each area.

Text
Choose text color of current area.    This command presents color picker.

Background
Choose background color of current area.    This command presents color picker.

Use default system color
Check this option to use default system color in current area.

Reset Default
Press this button if you want to reset all color settings to the default value.



Print page (Preferences dialog box)

In this page, You can specify how the document should be printed:

Margins
Sets the printing margin of the active document.

Draw margin in preview
Displays margins in preview mode

Header and footer
Specifies the header and footer text of the active document. You can use the header/footer macros as
well as normal text.

Draw separating line
Draw line between the document and the header/footer.

Ignore text color
Ignores all the text colors and prints only in black and white.

Printer
Invokes the Print Setup dialog box.



Header/Footer Macros

The following macros can be used in Footer and Header field in Print page of Preferences dialog box.

Mac
ro

Description

&f Inserts current file name.    
The file name does not 
include path.

&F Inserts current file name 
with full path.

&p Inserts page number of 
current page.

&P Inserts total number of 
pages of current 
document.

&d Inserts current date.
&t Inserts current time.
&C Align following text to 

center.    This is default 
value if you don't specify 
any align option.

&L Align following text to left.
&R Align following text to right.



Files page (Preferences dialog box)

In this page, you can specify file options.    Following options are available.

Number of recent file list
EditPlus maintains recent file list which appears at File menu.    Specify the number of recent file 
which is shown in this list.

Auto-save interval
Specify the interval for the auto-saving feature.    If you specify zero, the auto-saving feature will be 
disabled.

PC format
Check this option to set PC file format for newly created document.

UNIX file format
Check this option to set UNIX file format for newly created document.

MAC file format
Check this option to set MAC file format for newly created document.

Create back-up file when saving
Check this option to create back-up file when saving the document.    The name of the back-up file will
be the same as the original document and have ".BAK" extension.



Settings page (Preferences dialog box)

You can specify different settings to each different file type.    Following options are available.

File types
This window displays available file types.    Choose file type which you want to set options for.    You 
can add or remove file types using Add/Remove buttons.

Add
Press this button if you want to add a new file type.

Remove
Press this button if you want to remove current file type.    You cannot remove the default file type.

Description
Specify the description of current file type.

Extensions
Specify file extensions of current file type.    You must separate each extension by semicolon(;).    For 
example, HTML file type has following extensions - html;htm;asp;shtml.

Show line number
Check this option to show line number.    Line number can increase readability of program source or 
HTML files.

Word wrap
Check this option to set word-wrap feature turned on in current file type.

Auto indent
Check this option to set auto-indent feature turned on in current file type.

Tab size
Specify tab size of current file type.

Auto-completion file
Specify the path of auto-completion file of current file type.    See Auto-completion for more details.

Enable auto-completion
Check this option to turn on the auto-completion feature in current file type.    This option is 
unavailable if auto-completion file is not specified.    See Auto-completion for more details.



Syntax page (Preferences dialog box)

In this page, you can customize syntax highlighting feature.    You can customize existing syntax 
properties or add your own syntax file.

Syntax types
This window displays available syntax.    You can Add or remove syntax types using Add/Remove 
buttons.

Add
Press this button if you want to add a new syntax file.    Syntax file has ".STX" extension.    You can 
customize or create new syntax file.    Syntax file should be written in predefined format.    See Syntax 
Highlighting for more details about syntax file.

Remove
Press this button if you want to remove current syntax type.

Extension
Specify the file extension which current syntax type applies to.    You should separate each extension 
by semicolon(;).    For example, file extension of the HTML syntax type is html;htm;asp;shtml.

Load syntax file
Press this button if you want to load current syntax file into the editor.    Syntax file should be written in
predefined format.    See Syntax Highlighting for details.

Color pickers
You can customize keywords and other syntax colors by pressing corresponding color button.

Disable syntax highlighting
Check this option to disable syntax highlighting.



File Filters page (Preferences dialog box)

In this page, you can specify file filters which is shown in File Open dialog box:

File Filters
This box lists file filters which appears in File Open Dialog box.

Add
Add a new file type.

Remove
Removes the selected file type.

Up
Moves up the selected file type.

Down
Moves down the selected file type.

Description
Specifies the description of the selected file type.

Wild Cards
Specifies the wild card pattern for the selected file type.

Add to Common Files filter
Add the selected file type to Common Files filter.



Templates page (Preferences dialog box)

In this page, you can specify document templates which is shown in File-New menu.    See Document 
Template for more detail about document template.

File Types
This box lists registered document templates.

Add
Add a new document template.

Remove
Removes the selected document template.

Up
Moves up the selected document template.

Down
Moves down the selected document template.

Menu text
Specifies the description of the selected document template which will be shown in menu item.

File path
Specifies the path of template file.

Load
Load current template file into the editor.



Tools page (Preferences dialog box)

In this page, you can specify Tools settings

Browser
Specify the browser type for the New Browser Window command and View in Browser command.
Seamless browser window 
Seamless browser window enables previewing HTML files or Java applets without leaving the editor.   
It also has common browsing features that helps to surf the web.    This feature requires IE 3 or 
higher.
System default browser 
If this option is checked, EditPlus calls operating system's default web browser as external 
application.
Other browser 
Choose other browser. Enter full path of the browser that you want to use.

Allow double-column toolbar
When this option is checked, the standard toolbar shows two columns when it is docked vertically.    
This prevents the toolbar from being clipped when the height of the toolbar is bigger than the size of 
screen.

Allow wrapping in HTML toolbar
This option allows the HTML toolbar to be wrapped when there is not enough space to show all 
buttons.

Display short-cut key in tooltip text
When this option is checked, short-cut key of current command is displayed in tooltip.



Keyboard page (Preferences dialog box)

In this page, you can customize keyboard shortcuts.

Types
This window displays available command categories.

Commands
This window displays available commands in current category.

Reset All
Press this button if you want to reset all the keyboard shortcuts to the default value.

Save As
Press this button if you want to save current keyboard shortcuts to external file.    You can load the file 
and restore the keyboard shortcuts later. 

Load
Press this button if you want to load saved keyboard shortcut file.

Press new shortcut
Press key that you want to assign to current command.

Current keys
This window displays shortcuts that is applied to current command.

Assign
Press this button if you want to assign shortcut you pressed to current command.    Multiple shortcuts 
can be assigned to one command.

Remove
Press this button if you want to remove selected shortcut from current command.



Spell Checker page (Preferences dialog box)

In this page, You can set spell checker options.

Ignore HTML tags
Check this option to skip HTML tags.

Ignore URLs and E-mail addresses
Check this option to skip URLs and E-mail addresses.

Ignore all-caps words
Check this option to skip words that contain only capital letters.

Ignore mixed case
Press this button if you want to skip words that contain uppercase letter other than the first letter. For 
example ScanDisk, WordPad, etc.

Sort the list of suggestions alphabetically
Sort the list of suggestions by alphabetical order.

Dictionary location
Specify dictionary file.    Dictionary file has ".DIC" extension.    Currently EditPlus provides 
English(US+UK) dictionary only.

User dictionary
User dictionary file is plain text file that has ".USD" extension.    You can add items into this file by Add
or Add Uncap command in the Spell Checker dialog box.



User Tools page (Preferences dialog box)

In this page, you can configure user tools.    User tool is user-defined application or Help file that EditPlus 
will launch and optionally capture the output.

Menu items
This listbox displays the menu text of user tools which will be shown in Tools menu.

Add program
Press this button if you want to add a new program.    You can add up to 20 tools.

Add help file
Press this button if you want to add a help file.

Remove
Press this button if you want to remove current tool.

Up
Moves up the selected tool.

Down
Moves down the selected tool.

Menu text
Enter the text of the tool which will be displayed in the menu item.

Command/Help file
Enter the executable file or help file of current tool.

Argument
Enter the argument that you want to pass to the tool.    This option is not available when current tool is
a help file.    You can also insert Argument Macros in this field.

Initial directory
Enter the initial directory where the tool should be executed.    This command is not available when 
current tool is a help file.

Capture output
Capture the output of the tool.    This option is only applicable to console application.    If you check 
this option, the output of the tool will be captured.    This feature is useful when you want to capture 
error messages of a compiler.    See Output Window for details.

Run minimized
If this option is checked, the tool will be minimized when it starts.    This option is not available if the 
tool is a help file.

Close window when exit
When this option is checked, the tool will be closed after it finished operation.    This option is only 
applicable to the console application.    This option is not available if you checked Capture Output 
option.

Prompt for arguments
If this option is checked, a dialog that prompts argument will be shown before the tool starts.



Argument Macros

The following macros can be used in Argument field in User Tools page of Preferences dialog box.

Macro Description
$
(FileP
ath)

Inserts file name of 
current document with 
full path.

$
(FileN
ame)

Inserts file name of 
current document 
without path.

$
(FileN
ameN
oExt)

Inserts file name of 
current document 
without path and 
extension.

$
(FileE
xt)

Inserts file extention of 
current document.

$
(CurLi
ne)

Inserts current line 
number where the caret 
is located.

$
(CurC
ol)

Inserts current column 
index where the caret is 
located.

$
(CurS
el)

Inserts selected text.

$
(CurW
ord)

Inserts current word.





Window menu commands

The Window menu offers the following commands, which enable you to arrange multiple views of multiple
documents in the application window:

Split Splits the active window 
into panes.

Next 
Pane

Switches to the next 
window pane.

Previo
us 
Pane

Switches to the previous
window pane.

Casca
de

Arranges windows in an 
overlapped fashion.

Tile 
Horizo
ntally

Arranges windows as 
non-overlapping tiles 
horizontally.

Tile 
Vertic
ally

Arranges windows as 
non-overlapping tiles 
vertically.

Arrang
e 
Icons

Arranges icons at the 
bottom of the window.

Close 
All

Closes all document 
windows.

Windo
w 1, 2,
...

Goes to specified 
window.



Split Command (Window menu)

Use this command to split the active window into panes.    You may then use the mouse or the keyboard 
arrows to move the splitter bars.    When you are finished, press the mouse button or enter to leave the 
splitter bars in their new location.    Pressing escape keeps the splitter bars in their original location. 



Next Pane (Window menu)

Use this command to switch to the next window pane.



Prev Pane (Window menu)

Use this command to switch to the previous window pane.



Cascade command (Window menu)

Use this command to arrange multiple opened windows in an overlapped fashion.



Tile Horizontal command (Window menu)

Use this command to vertically arrange multiple opened windows in a non-overlapped fashion.



Tile Vertical command (Window menu)

Use this command to arrange multiple opened windows side by side.



Window Arrange Icons Command

Use this command to arrange the icons for minimized windows at the bottom of the main window.    If 
there is an open document window at the bottom of the main window, then some or all of the icons may 
not be visible because they will be underneath this document window.



Close All Command

Use this command to close all document windows.



1, 2, ... command (Window menu)

EditPlus displays a list of currently open document windows at the bottom of the Window menu.    A check 
mark appears in front of the document name of the active window.    Choose a document from this list to 
make its window active.





Help menu commands

The Help menu offers the following commands, which provide you assistance with this application:

Help 
Topics

Offers you an index to 
topics on which you can 
get help.

Conte
xt 
Help

Displays help on clicked 
on buttons, menus and 
windows.

How 
to 
Regist
er

Displays information 
about ordering.

Order 
Online

Visit EditPlus Order-
online web site.

Enter 
Regist
ration 
Key

Enters registration code.

Feedb
ack 
and 
Suppo
rt

Display information 
about feedback and 
support.

About Displays the version 
number of this 
application.



Help Topics command Command (Help menu)
Use this command to display the opening screen of Help.    From the opening screen, you can jump to 
step-by-step instructions for using EditPlus and various types of reference information.

Once you open Help, you can click the Contents button whenever you want to return to the opening 
screen.



Context Help command (Help menu)

Use the Context Help command to obtain help on some portion of EditPlus.    When you choose the 
Toolbar's Context Help button, the mouse pointer will change to an arrow and question mark.    Then click 
somewhere in the EditPlus window, such as another Toolbar button.    The Help topic will be shown for the
item you clicked.

Shortcut

Toolbar:
Keys: Shift+F1



Order Online command (Help menu)

Use this command to visit EditPlus homepage and register online on the web site.    See Register 
Information for more details on registration.



Enter Registration Key command (Help menu)

Use this command to enter registration key which will unlock the evaluation version of EditPlus.    This 
command presents Enter Registration Key dialog box.    See Register Information for more details on 
registration.



Enter Registration Key dialog box

In this dialog box, you can enter registration key which unlocks the evaluation version of EditPlus.    
Registration key is delivered to registered user.    See Register Information for more details.    If you have 
any trouble in registration process, please contact the author at escomp@soback.kornet.nm.kr.

User name
Enter exact user name which is delivered to you with registration key.

Registration key
Enter exact registration key.



About command (Help menu)

Use this command presents About dialog box which displays the copyright notice and version number of 
your copy of EditPlus.



About dialog box

This dialog box displays copyright information, name of the registered user, and system informations.    If 
you registered EditPlus, your name will be displayed here.    For more information about registration, see 
Register Information.    See also License Agreement.






